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WriteBoard 
High school English class. Freshman year. The teacher explained how to: 

1. Write a thesis statement. 
2. Create an outline of arguments supporting your thesis statement. 
3. Write a paper based on that outline. 

That's actually a terrible way to write! It requires you to organize your 
thoughts before you know what those thoughts actually are. But there is a better 
way. 

Brainstorm, Organize, Write 
Before you can organize your thoughts, you need to know what they are. In the 
days before computers, you'd find out like this: 

1. Get a package of index cards. 
2. On each card, write an idea related to your thesis (the fancy word for 

whatever it is you want to write about). Do not try to do this in any kind of order; 
you're brainstorming here: good ideas, bad ideas, any ideas—they all go down on 
the cards. When your brain is empty, stop. 

3. On a big desk or table, spread the cards out in front of you. Keep them 
messy. 

4. Read the cards and stack those on a certain subject together until you have 
several stacks. Discard (pardon the pun) those that don't belong anywhere or that 
now seem irrelevant or stupid. 

5. Put the cards in each stack in some kind of order. Importance? Chronology? 
You choose. 

6. Put the stacks in some kind of order. Each stack represents a section of your 
paper. 

7. Write your paper, starting with the first card and ending with the last. Each 
stack gets a subheading. Each card gets a paragraph. 

8. Edit your paper as needed. 

Again, that was in the days before computers. Now we have much better ways 
of doing what I've just described, with new card-based writing programs popping 
up all the time. Some of my favorites are: 

• Notebox Disorganizer  
• Milanote 
• Speare 
• SuperNotecard 

https://archive.org/details/notebox-disorganizer
https://milanote.com/
https://www.speare.com/
https://www.supernotecard.com/
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“But,” you say, “I’m used to working in Microsoft Word. Isn’t there a way to do 
card-based writing in Word?” Yes, there is! 

Welcome to WriteBoard! 
WriteBoard is like a giant whiteboard on which you place sticky notes while 
constructing your literary masterpiece, allowing you to see your whole novel (or 
other work) laid out in front of you. For example, here’s a bit of J. K. Rowling’s 
planning sheet for Harry Potter and the Order of the Phoenix: 

 

It did the job, but it’s not easy to read. In WriteBoard, it could look like this: 

 

You might use each WriteBoard column to plan a chapter, with each cell in the 
column representing a scene. Then if you want to move a scene in chapter 1 over to 
chapter 4, you can do so with a couple of keystrokes. You can move, insert, or 
delete cells, rows, and columns until everything is arranged exactly the way you 
want it, then export your work as a single document. WriteBoard makes it easy. 
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You can use WriteBoard to plan and keep track of all kinds of things. For 
example, you can use it as a kanban (look it up) to keep track of your projects and 
where they are in production: 

 

Possible 
projects 

In progress Finished Final review Submitted 

Great 
American 
Novel 

    

 
 

 
 

 
 

 
 

Crossword 
puzzle for the 
NY Times 
 

 
 

 
 

 
 

Paper on 
nuclear 
fusion 
 

 

Article on 
chimps for 
Atlantic 
magazine 

    

 
 

Try out 
WriteBoard 
 

   

 
You can insert graphics and use it for storyboarding: 

 

Try using an AI engine like Microsoft Designer to generate images for your story. If 
you have Microsoft Copilot, you can do that directly in Word.  

        

 

https://designer.microsoft.com/image-creator
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You can use WriteBoard to plan your week, especially useful if you’re into time 
stacking: 

 

Monday Tuesday Wednesday Thursday Friday 

Do laundry Outline novel Sleep in Write chapter 
introducing 
ancient castle 

Clean garage 

Finish article 
for Rolling 
Stone 

 Lunch with 
Marie 

 Wash car 

 Dr. visit, 3:00 Research for 
screenplay 

 Clean up hard 
drive 

 Outline novel  Call potential 
clients 

 

 Call Mom   Date night 

 
For planning your chapters, consider something like this (fill in the blanks): 
 

Chapter Striking 
beginning 

Setting Characters Action Cliffhanger 
ending 

1      

2      

3      

4      

5      
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You can also use it to keep track of characters in your novel: 
 

Character Appearance Personality Background Goal 

Brad the 
Impaler 

Ugly little 
spud. Red 
hair, yellow 
eyes, long 
scar on left 
cheek. 

Nasty. Hurts 
people just 
for fun. 

Orphaned. 
Grew up in a 
camp of 
robbers. 

Kill his 
enemy, the 
Duke of 
Castille. 

Duke of 
Castille 

Tall, thin, 
black hair, 
dark eyes. 

Aloof and 
demanding. 

Wealth and 
privilege. Son 
of royalty. 

Become king 
of Castille. 

Belinda the 
Fair 

Blond, blue 
eyes. Fairly 
beautiful. 

Kind to all. 
Especially 
loves animals. 

Daughter of 
peasants. 
Lives in the 
village of 
Fitzroy. 
Works as a 
baker. 

Marry her 
true love, 
Norman the 
Normal, and 
raise little 
Belindas. 

Norman the 
Normal 

Chubby, 
nondescript. 
Brown eyes 
and hair. 

Timid and 
kind, always 
hopeful. 

Son of 
peasants. 
Lives in the 
village of 
Fitzroy. 
Works in the 
stables. 

Become the 
owner of his 
favorite 
horse, Sparky. 

Sparky Black horse 
with white 
stripe on face. 

Skittish, 
energetic. 

Raised in the 
stables of 
Fitzroy. 

Escape from 
Fitzroy. 

 

WriteBoard provides a great way to see the big picture of almost anything. 
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WriteBoard’s ribbon interface looks like this: 

 

Most of the items under each tab on the ribbon are self-explanatory (for example, 
“Move cell right”), but a few of them need explanation. 

WriteBoard 

 

CREATE WRITEBOARD 

Create WriteBoard creates a new WriteBoard document, which is really just an 
enormous Microsoft Word document (22 by 22 inches) containing a specially 
formatted table. 

When you create a WriteBoard, the program will ask you to name it: 
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The program will create and save your new WriteBoard in your Documents folder 
in a subfolder with the same name as the WriteBoard. You’ll soon see why that is 
important. 
 
A new WriteBoard looks like this: 

 

Each cell in the table is the equivalent of an index card or a sticky note, and you 
can type in the cells and arrange them at will. 

You can do anything with this table that you can with a regular table, using 
Word’s usual features. And, of course, you can use it with all of the special features 
included in the WriteBoard program. 

When you create a WriteBoard, the program will ask how many columns and 
rows you want to include in the WriteBoard table. You can have up to 100 rows, 
but WriteBoard initially creates a maximum of 30 columns. I recommend starting 
with a more reasonable number, such as 8 or 10. You can always add more 
columns and rows if you need them, up to whatever maximum Word supports. 

The more columns you specify, the more WriteBoard reduces the point size in 
those columns, ensuring that your text is legible and doesn’t look like this: 

 

Writing 
in a 
narrow 
column. 

 
To make up for the reduction in point size, it automatically enlarges the zoom 
percentage so your text is always easy to see. 

OPEN WRITEBOARD FOLDER 

Open WriteBoard Folder opens the folder containing your WriteBoard in case you 
need to access the linked documents that are stored there. 

SORT WRITEBOARD 

Sort WriteBoard displays Word’s standard Sort dialog, which you can use to sort 
the cells in your WriteBoard table: 
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The WriteBoard table includes a header row, so you can sort by that if you need to. 

Hyperlink 

 

ADD CELL HEADING 

Add cell heading styles the first paragraph in a cell as a heading. If the cell is at the 
top of the column, its first paragraph is styled as Heading 2. (Think of this as a 
chapter heading.) If the cell is anywhere else, its first paragraph is styled as 
Heading 3. (Think of this as a subheading within the chapter.) This works no 
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matter where your cursor is in the cell; it doesn’t have to be in the first paragraph. 
If the cell is empty, this adds a paragraph break and styles it, ready for you to type. 

You don’t need to add a heading to every cell, but doing so to some of them 
will help you better organize your writing. 

OPEN HYPERLINK 

If a cell includes a heading, Open hyperlink opens the document that is linked to 
the heading. If the heading is not linked to a document, the program offers to 
create one: 
 

 
 
You can create a normal document or another WriteBoard. That’s right—a 
WriteBoard can include links to other WriteBoards as well as normal documents. 
Open hyperlink opens either one. 

CREATE HYPERLINKED DOCUMENT 

If a cell includes a heading, Create hyperlinked document creates a normal 
document that is linked to the heading, using the heading as its filename. For 
example, if a cell has a heading of “Chapter 1,” Create hyperlinked document creates 
a document named “Chapter 1.” You’re given the option of including the cell’s text 
in the document. If you select the linked cell and cells below it in the same 
column, the program gives you the option of including the text from the selected 
cells in that column. 

The point is to plan your project in WriteBoard but do your actual writing in 
separate documents that are linked to the corresponding cells in your WriteBoard. 
NOTE: The documents are kept in the same folder as your WriteBoard, so they’re all 
in the same place and not just scattered about. 

Most writers will prefer working in this way, as it means writing in regular 
Word documents, one for each hyperlink. An alternative is to write in the 
WriteBoard table itself, chapter after chapter, scene after scene. 
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CREATE HYPERLINKED WRITEBOARD 

If a cell includes a heading, Create hyperlinked WriteBoard creates a WriteBoard 
that is linked to the heading, using the heading as its filename. For example, if a 
cell has a heading of “WriteBoard 2,” Create hyperlinked WriteBoard creates a 
WriteBoard named “WriteBoard 2” and saves it in the folder associated with your 
original WriteBoard. 

You might plan your overall fantasy trilogy on your main WriteBoard with 
links to other WriteBoards for volume 1, volume 2, and volume 3. Then, in the 
WriteBoard for volume 1, you can include links to separate documents for chapter 
1, chapter 2, chapter 3, and so on. 

NOTE: Any linked WriteBoard in your WriteBoard’s folder can include links to 
any documents in that folder, even those already linked to a different WriteBoard. 
For example, you could link your “Plot” document to three different WriteBoards. 

REMOVE HYPERLINK 

Remove Hyperlink removes the hyperlink from a cell’s heading but leaves the 
heading intact. It also offers to delete the document linked to the heading: 

 

Export 
After you’ve finished writing, either in separate documents or in the WriteBoard 
table, you’ll want to export your masterpiece as a single document. 
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CREATE DOCUMENT FROM SELECTED CELLS 

Create document from selected cells creates a new document containing the text from 
the cells you’ve selected. If you’ve written in the cells themselves, this feature exports 
parts of your writing (such as a chapter or section) into a new document. 

Your selection can be arbitrary, even spanning columns, but the selected cells 
must be contiguous. For example, if you select cell 3 in column 6 and cell 4 in faraway 
column 12, only the text in cell 3 is exported. But if you select cells 3 and 4 in both the 
adjoining columns 6 and 7, the export includes the text from all the selected cells. 

CREATE DOCUMENT FROM ALL CELLS 

Create document from all cells creates a document with the text from all of the 
WriteBoard cells, selected or not. Use this to compile your master plan into one 
document as the basis for your working manuscript. 

CREATE DOCUMENT FROM LINKED DOCUMENTS IN SELECTED CELLS 

Create document from linked documents in selected cells creates a new document 
containing the text from the hyperlinked documents in the cells you’ve selected. 
For example, if you want a document that includes the linked documents for 
chapters 1 through 3, you could select columns 1, 2, and 3 and then use this feature. 
Again, selected cells must be contiguous. NOTE: Linked WriteBoards are not 
included in the created document—only normal documents are included. 

CREATE DOCUMENT FROM ALL LINKED DOCUMENTS 

Create document from all linked documents creates a new document containing the 
text from all of the documents that are linked in the WriteBoard table, whether 
selected or not. Again, only normal documents are included. 

SET EXPORT DIRECTION (VERTICAL OR HORIZONTAL) 

Set export direction allows you to set the direction in which exporting works, 
allowing for great flexibility in how you put your WriteBoard together. For 
example, if your book has 50 chapters, you may find it easier to plan each chapter 
in its own row rather than its own extremely narrow column. Then you can export 
your plan row by row (horizontally) rather than column by column (vertically). 
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Metadata 

 

The metadata features let you enter and save information about the documents 
linked to your WriteBoard. Then you can generate a report showing that 
information for all of them. You don’t have to use these features, of course, but you 
may find them helpful, especially while writing that gigantic fantasy trilogy. 

ENTER METADATA FOR OPEN LINKED DOCUMENT 

Let’s say you want to keep track of which characters appear in each scene. When 
you open a linked document to work on a scene, click Enter metadata for open 
linked document (or press SHIFT ALT M). You’ll get a dialog that looks like this: 
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Enter the names of the characters in the scene. You can enter other information as 
well: setting, point of view, status (in progress, finished), and so on—whatever you 
want to track. When you’re through, click OK. Be sure to save your document so 
your information doesn’t get lost. 

NOTE: Again, the keyboard shortcut to open this dialog is SHIFT ALT M (for 
“Metadata”). 

If you get tired of repeatedly entering the same information (“Setting: Castle,” 
“Setting: Castle,” “Setting: Castle”), click “Use Previous Entries” to populate the 
dialog with the entries you made in an earlier document. Then modify the entries 
as needed.  To remove all the current entries from the dialog, click “Clear All.” 

CREATE METADATA REPORT FOR ALL LINKED DOCUMENTS 

After you’ve entered metadata in your linked documents, you can create a report 
that summarizes that metadata for all the linked documents in your WriteBoard. 
The report is useful for seeing which scenes include which characters, in which 
settings, and so on. The report also shows the number, name, and word count for 
each document. 

SORT METADATA REPORT 

If you like, you can sort the metadata report in various ways. Want to see all the 
scenes that are still in progress? Sort the table by “Status.” Want to see all the 
scenes that take place in the scary castle? Sort the table by “Setting.” 

SET METADATA HEADINGS FOR WRITEBOARD 

The default metadata headings are Setting, Characters, Point of View, Date, Time, 
Purpose, Other 1, Other 2, and Status. If you’re writing a novel, those headings 
work fine, but what if you’re writing a personal history or a treatise on poetry? In 
such cases, you may need to use custom metadata headings rather than the 
defaults. This feature makes that possible. Enter your custom headings and click 
OK. Be sure to save your WriteBoard so your headings don’t get lost. 
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Size 

 

The “Toggle height” features let you see all of your text in all of the rows at once, or 
all of the text in one row at a time, making it easier to understand the big picture 
or focus on a single detail. The purpose of the other features is obvious. 

NOTE: Remember to “Reset zoom” to your default settings when you’ve 
finished using WriteBoard. 

TOGGLE HEIGHT ALL ROWS 

The height compressed for all the rows looks like this: 
 

Character 

Brad the Impaler 

Duke of Castille 
 

             Belinda the Fair 
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And the height expanded for all the rows looks like this: 

Character 

Brad the Impaler 
 

This sentence shows what happens when you toggle the height of all rows. 

Duke of Castille 
 
This sentence shows what happens when you toggle the height of all rows. 

Belinda the Fair 
 
This sentence shows what happens when you toggle the height of all rows. 

TOGGLE HEIGHT ONE ROW 

The height compressed for a single row looks like this: 

Character 

Brad the Impaler 
 

This sentence shows what happens when you toggle the height of one row. 

Duke of Castille 
 
This sentence shows what happens when you toggle the height of one row. 

Belinda the Fair 
 

              
And the height expanded for a single row looks like this: 

Character 

Brad the Impaler 

Duke of Castille 

Belinda the Fair 
 
This sentence shows what happens when you toggle the height of one row. 
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Cursor 

 

You can, of course, move your cursor from cell to cell using Word's defaults of 
TAB, SHIFT TAB, and the up and down arrow keys. But the advantage of moving 
around with WriteBoard's shortcut keys is that they all select the text of the cell 
you move to, so you can easily see where your selection is, and you can press an 
arrow key to move to the beginning or end of the selection, ready to type. 

The only other feature here that needs explaining is Insert time stamp. It 
inserts the current date and time in this format: 
 

year.month.day hour.minute.second (using a 24-hour clock) 
 
For example, here is the time stamp as I write this: 
 
2024.03.28 13.12.52 
 
That’s March 28, 2024, at 1:12 (and 52 seconds) in the afternoon. 
Time stamps are useful for tracking when you’ve worked on a particular item 

or if you’re keeping journal entries. If you use a time stamp at the top of your cells, 
you can later sort the cells by time stamp. You can also use this feature to create 
Zettelkasten entries. (Look it up.) 
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Cells 

 

What these features do is obvious but they still need a little explanation. 

MOVE CELLS UP OR DOWN 

If you move a cell up or down, it swaps places with the cell above or below it in the 
same column. For example, let’s say you have Cell A and Cell B in the same 
column. If you move Cell A down, it moves below Cell B, and Cell B is now above 
Cell A.  

MOVE CELLS LEFT OR RIGHT 

However, if you move a cell left or right, it does not swap places with the cell to its 
left or right. Instead, the cell moves left or right into the adjoining column, and the 
cells around it move up or down to accommodate its new position. For example, 
let’s say you have Cell A in Column 1 and Cell B next to it in Column 2. If you move 
Cell A to the right, the cells that were below Cell A move up, and Cell B and the 
cells below it move down, leaving Cell A above Cell B, with the other cells still in 
their original columns. 

Why not just swap cells in adjacent columns? Because usually each column 
represents a chapter, with each cell representing a section or a scene. If you want 
to move a scene from chapter 3 to chapter 4, you probably don’t want to also move 
the adjacent scene from chapter 4 to chapter 3. You simply want to move the scene 
from one chapter to another, leaving the other scenes in place. 
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Writing with WriteBoard 
There are lots of ways to write with WriteBoard. One way is to follow the basic 
steps you’d use when planning your writing with index cards, using the cells in the 
WriteBoard table. When you’re finished, export your work. Then do your actual 
writing in the exported document, following the plan described therein. Another 
way is to write in the individual documents that you’ve linked to the headings in 
your plan. When you’re finished, export all of those documents as a single 
document ready for editing and review. Whatever your preference, the following 
steps work well. 

Brainstorm 
In each cell, write an idea you want to include in your paper or book. Do not try to 
do this in any kind of order; you're brainstorming here: good ideas, bad ideas, any 
ideas—they all go into the cells. When your brain is empty, stop. 

WriteBoard includes a special keyboard shortcut to make brainstorming faster: 
SHIFT ENTER. Using that shortcut, you can quickly move your cursor to the next 
cell down without moving your fingers from the home row on your keyboard. 
Brainstorm an idea, type it in, and instantly move to the next cell, ready to type 
some more. 

Organize 
Move the cells around, grouping those on a certain subject together, with one 
subject per column. Give each column a heading, and delete any ideas that now 
seem unnecessary. 

Put the cells in each column in some kind of order, with each cell representing 
a scene or a section. 

Put the columns in some kind of order, with each column representing a 
chapter. 

Write 
Write your paper or book. You can write in the documents that are hyperlinked to 
cell headings (recommended) or in the cells themselves. 

Export 
However you write, you can export your masterpiece as a single document after 
you’ve finished. Your text will be exported in the order set with the Set export 
direction (vertical or horizontal) feature. 
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Of Planners and “Pantsers” 
As you may know, many writers see themselves as either planners or “pantsers” 
(those who write “by the seat of their pants”). The planners work out their plots 
ahead of time, character by character, scene by scene, chapter by chapter. Then 
they write their novel according to their plan. 

“Pantsers” believe that all of that planning gets in the way of creativity and 
spontaneity, and if the planning is too detailed, they may be right. It’s important to 
leave room for the plot to go in a slightly different direction or for a character to 
do something unexpected. It’s amazing what riches the mind can reveal if given 
free reign. 

On the other hand, writing without some kind of plan may result in folders 
full of partially finished novels, potential masterpieces that never got past the first 
fifty pages. I know whereof I speak. 

One of the beauties of card-based writing, as with WriteBoard, is that you get 
the best of both planning and “pantsing.” You know your novel’s structure ahead 
of time so you don’t get stuck after chapter 5, but you also have plenty of room 
within that structure for creativity, for serendipity, for inspiration. “Pantsers” 
suddenly know where they’re going; planners find they can go off the path without 
losing sight of the destination. 

 It’s a wonderful thing. I urge you to try it, and I’ll wager that you find yourself 
writing more creatively and with greater ease and productivity than ever before. 

Thanks for using WriteBoard! 
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Keyboard Shortcuts 
WriteBoard is best used with its keyboard shortcuts, which are well organized and 
systematic. You can learn to use them quickly and easily by opening the document 
named “Keyboard Practice.docx” included with WriteBoard. 

Start with your left ring finger on the CTRL key and your left thumb on the 
ALT key, which is where they’ll often be when using WriteBoard’s features. Then 
put your right index finger on the LEFT arrow key. Now try some of the shortcuts 
listed below. You’ll get the hang of things in no time. 

Navigate > Cursor 
CTRL ALT. With an ARROW key, moves your cursor from cell to cell. With 
HOME and END, moves your cursor to the cell’s top or bottom. With INSERT, 
inserts a time stamp. 
 

 

CTRL ALT LEFT moves your cursor one cell to the left. 

 

CTRL ALT RIGHT moves your cursor one cell to the right. 

 

CTRL ALT UP moves your cursor up a cell. 

 

CTRL ALT DOWN moves your cursor down a cell. 
SHIFT ENTER does the same thing, without moving your fingers 
from the home row on your keyboard. Great for fast brainstorming. 

 

CTRL ALT HOME moves your cursor to the top of the cell. 

 

CTRL ALT END moves your cursor to the bottom of the cell. 

 

CTRL ALT INSERT inserts a time stamp. 
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Organize 

CELLS 

SHIFT ALT. With an ARROW key, moves a cell to a new location. With INSERT 
and DELETE, inserts or deletes cells. With HOME and END, selects or clears a 
cell’s text. 

 

 

SHIFT ALT LEFT moves a cell left, then adjusts the position of 
adjoining cells. 

 

SHIFT ALT RIGHT moves a cell right, then adjusts the position of 
adjoining cells. 

 

SHIFT ALT UP moves a cell up. 

 

SHIFT ALT DOWN moves a cell down. 

 

SHIFT ALT INSERT inserts a cell below the current cell, shifting the 
cells below it down. 

 

SHIFT ALT DELETE deletes the current cell, shifting the cells below 
it up. 

 

SHIFT ALT HOME selects a cell’s text. 

 

SHIFT ALT END clears (deletes) a cell’s text. 
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ROWS 

CTRL SHIFT ALT. With an ARROW key, moves a row up or down. With HOME 
and END, inserts or deletes rows. 
 

 

CTRL SHIFT ALT UP moves a row up. 

 

CTRL SHIFT ALT DOWN moves a row down. 

 

CTRL SHIFT ALT HOME inserts a row, shifting the following rows 
down. 

 

CTRL SHIFT ALT END deletes a row, shifting the following rows up. 

COLUMNS 

CTRL SHIFT ALT. With an ARROW key, moves a column left or right. With PAGE 
UP and PAGE DOWN, inserts or deletes columns. 
 

 

CTRL SHIFT ALT LEFT moves a column left. 

 

CTRL SHIFT ALT RIGHT moves a column right. 

 

CTRL SHIFT ALT PAGE UP inserts a column, shifting the following 
columns to the right. 

 

CTRL SHIFT ALT PAGE DOWN deletes a column, shifting the 
following columns to the left. 
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File > Hyperlink 

 

CTRL ALT H adds a cell heading. 

 

CTRL ALT O opens a document or WriteBoard hyperlinked to a cell’s 
heading. 

 

CTRL ALT N creates a normal hyperlinked document named for a 
cell’s heading. 

 

CTRL ALT M creates a hyperlinked WriteBoard named for a cell’s 
heading. 

 

CTRL ALT L removes the link from a cell’s heading but leaves the 
heading intact. It then gives you the option of deleting the document 
or WriteBoard associated with the link. 

View > Size 

 

CTRL ALT PAGE UP toggles the height of all rows. 

 

CTRL ALT PAGE DOWN toggles the height of the current row. 

 

CTRL ALT 9 fits all of your WriteBoard columns into your Word 
window. 

 

CTRL ALT + zooms in. 
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CTRL ALT – zooms out. 

 

CTRL ALT 0 resets the zoom to your default settings, as they were 
before you used WriteBoard. 

General Guidelines 
•   CTRL ALT is used with your cursor (also hyperlinks, zoom, and time stamps). 
•   SHIFT ALT is used with cells. 
•   CTRL SHIFT ALT is used with rows and columns. 

 

•   INSERT and DELETE (with SHIFT ALT) insert and delete cells. 
•   HOME and END (with CTRL SHIFT ALT) insert and delete rows. 
•   PAGE UP and PAGE DOWN (with CTRL SHIFT ALT) insert and delete columns. 

 

 

cells rows columns 

insert 
 
 
 
 
 
delete 
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Resources 
You can find lots of articles about card-based writing online. Here are some good 
ones: 

 
The Note Card System 
 
Organize & Plan Your Book Using Index Cards 
 
Writing With Index Cards: A Low-Tech Way To Plan Your Book or Novel 
 
The Amazing Index Card Technique 
 
How to Outline a Story with Index Cards 
 
Create Structure in Your Fiction Using Index Cards 
 
Build Your Plot – My Index Card Method 
 
The 60 Index Card Method: How To Outline Your Novel In 3 Simple Steps 
 
Zero Draft Thirty: Story Prep Fun With Index Cards! 

https://gallaudet.edu/student-success/tutorial-center/english-center/writing/pre-writing-writing-and-revising/the-note-card-system/
https://heartbreathings.com/organize-plan-your-book-using-index-cards/
https://www.how-to-write-a-book-now.com/writing-with-index-cards.html
https://www.writebetterpoems.com/articles/index-cards-for-drafting
https://philhalton.com/2023/06/23/story-outline-index-cards/
https://www.writersdigest.com/there-are-no-rules/create-structure-in-your-fiction-using-index-cards
https://authorkrpaul.com/2021/01/17/build-your-plot-my-index-card-method/
https://fictionwritingwithai.substack.com/p/the-60-index-card-method-how-to-outline
https://gointothestory.blcklst.com/zero-draft-thirty-story-prep-fun-with-index-cards-94b3a8fc8b25
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Registration 
If you like WriteBoard and plan to continue using it, you must purchase a license 
to do so. If you don’t, your copy of the program is for evaluation purposes only, 
and it will stop working after 45 days. After you purchase a license to use the 
program, you’ll automatically receive a password (by email) that unlocks the 
program to run without limitation on time or use. 

The terms of your license prohibit you from giving your program password to 
someone else or using it on someone else’s computer. However, you may use the 
password on up to three of your own computers. For example, you could install 
WriteBoard and use your password on your computer at work, your computer at 
home, and your laptop. However, you may run the program on only one of your 
computers at a time. If you need to run the program on more than one computer 
at a time (for example, for use by a family member or employee), you must 
purchase another license and get another password for the program. This is the 
honest and legal thing to do. Besides that, the Editorium is a very small business 
that needs your support. Thanks for your cooperation. 

Getting a Password 
Here’s how to purchase a program license so you can get your password: 

1. Go to http://www.editorium.com/register.htm and click WriteBoard. Or, in 
Word, just click WriteBoard > Register WriteBoard > Purchase WriteBoard. 

  

2. Follow the online instructions. 

You’ll receive your password automatically by return email as soon as your 
payment is processed. If you’re paying by credit card, you’ll receive your password 
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almost immediately. Just check your email as soon as your online registration is 
complete. 

Using Your Password 
Once you’ve received your password from the Editorium, you’ll need to enter it 
into the WriteBoard program. To do so, click WriteBoard > Register WriteBoard. 
The Registration dialog will appear on your screen: 

  

Carefully type (or, better, paste) the password into the box labeled “Please enter 
your password/registration code.” Then click the OK button. 

If you have a valid password and enter it correctly, the program will tell you 
that your registration was successful. After that, the program will run without 
limitation on time or use. 
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Questions? 
I hope you find WriteBoard to be immensely useful. If you have questions, 
comments, or thoughts about how it could be improved, please let me know. 

 
support@editorium.com 
www.editorium.com 
 
The Editorium provides word-processing tools for editors, writers, typesetters, 

and other publishing professionals. You can download fully functioning evaluation 
copies of these tools free of charge from the Editorium’s site on the World Wide 
Web at www.editorium.com. 

This documentation and the WriteBoard software are copyright © 2024 by the 
Editorium. All rights are reserved. The Editorium and WriteBoard are trademarks 
of the Editorium. 

All trademarks mentioned in this documentation or the program are 
acknowledged as trademarks of their owners. 

https://www.editorium.com/
https://www.editorium.com/
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Terms of Agreement 
By using WriteBoard, you agree to these terms: 

 
LICENSE AGREEMENT 
 
The WriteBoard software and its documentation (collectively the Software) are 
protected by the United States copyright laws and international treaties and are 
owned solely and entirely by the Editorium (the licensor). 

You (the licensee) may run the Software on up to THREE computers, but only 
on one at a time. You may evaluate the Software at no charge for up to 45 days. 
After that, you must purchase a license to continue using the Software. 

You may freely transfer copies of the Software to others for evaluation. You 
may NOT let someone else use your password for the Software or rent or lease 
your license to run it, but you may transfer the license to someone else who 
accepts this agreement. 

You may not modify, reverse engineer, decompile, disassemble, unencrypt, or 
create derivative works from the Software. You may not use the Software in any 
manner that infringes the intellectual property or other rights of another party. 
You may not copy or sell the Software for commercial gain. 
 
DISCLAIMER OF WARRANTY AND LIABILITY 
 
The Editorium disclaims all warranties on the Software, expressed or implied, 
including but not limited to warranties of merchantability and fitness for any 
particular application, use, or purpose. You use it at your own risk. Under no 
circumstances, including its own negligence, shall the Editorium or its suppliers be 
liable for any special, incidental, or consequential damages or loss that result from 
the use of, or the inability to use, the Software. 

This agreement shall be construed, interpreted, and governed by the laws of 
the State of Utah in the United States of America. 


	Contents
	WriteBoard
	Brainstorm, Organize, Write
	Welcome to WriteBoard!
	WriteBoard
	Create WriteBoard
	Open WriteBoard Folder
	Sort WriteBoard

	Hyperlink
	Add cell heading
	Open hyperlink
	Create hyperlinked document
	Create document from selected cells
	Create document from all cells
	Create document from linked documents in selected cells
	Create document from all linked documents
	Set export direction (vertical or horizontal)

	Metadata
	Enter metadata for open linked document
	Create metadata report for all linked documents
	Sort metadata report
	Set metadata headings for WriteBoard

	Size
	Toggle height all rows
	Toggle height one row

	Cursor
	Cells
	Move cells up or down
	Move cells left or right


	Writing with WriteBoard
	Brainstorm
	Organize
	Write
	Export

	Of Planners and “Pantsers”
	Keyboard Shortcuts
	Navigate > Cursor
	Organize
	Cells
	Rows
	Columns

	File > Hyperlink
	View > Size
	General Guidelines

	Resources
	Registration
	Getting a Password
	Using Your Password

	Questions?
	Terms of Agreement

